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Creating A New User  

 

1.  Click the  toolbar button. 
                         

2.  Click “Create New User” in the ñUser Tasks” pane. 
            

                         

 

3.  Enter the information on the “Standard” and “Address” tabs 

 

Note 

 

Items marked with an asterisk (*) are required 
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4.   To enter a Key FOB number, you can either enter the number manually or use the Key 
FOB to enter it automatically. To enter it automatically: 

 

   

Place the cursor in the Key FOB field: 
  

 
 

Swipe the Key FOB over the reader: 
 

 
 

The card's Key FOB number appears 
automatically in the field: 
 

 

 

 

 

 

 

 

 

 

 

 

Note 
 

Key FOBs come 
in a variety of 
styles, so *he Key 
FOB shown here 
may n*t exactly 
match the one 
you are using. 
  

  

Click OK. 
 

The user(s) you create are displayed in the User 
Collection pane. 
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Deleting A User 

 

 Click the  button to make the User Tasks and User Collection pane visible.   
         

1.  Right-click the named user in the User Collection pane. 
 

2.  Select Delete from the context menu 
   

 

Note 

•      
     You may also delete the selected user by pressing the Delete key on your      

keyboard.  
  

 

 

Another way to delete a user: 
 

1.  Select Delete this User from the User Tasks pane. 
            

                                                        

 

Click the Yes button to delete the user. 

  

 

Notes 
 

The user and all associated records will be permanently 
deleted. 

•  i.   
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Editing A User 

 

 Click the  button to make the User Tasks and User Collection panes visible 

 

The first way to edit a user: 
 

1.  Right-click the named user in the User Collection pane. 
 

2.  Select Edit from the context menu. 
 

            

              
 

The second way to edit a user: 
 

1.  Select Edit this User from the User Tasks pane. 
            

                                                                        

 

Make the appropriate changes 

 

To change a Key FOB number, you can either enter the new number manually or use the 
Key FOB to enter it automatically. To enter it automatically: 
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Place the cursor in the Key FOB field: 
  

 
 

Swipe the Key FOB over the reader: 
 

 
 

The card's Key FOB number appears 
automatically in the field: 
 

 

 

 

 

 

 

 

 

 

 

 

Note 
   

•   Key FOBs come in a variety of styles so the 
Key FOB shown here may not exactly match 
the one you are using. 
  

 

 

2.  Press OK. 

 

Logging In A User 

 

There are two ways to log in a user: using a Key FOB or manually.  
 

Logging in using a Key FOB 
 
If you have a Key FOB, all you have to do is swipe the Key FOB over the reader:  
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[One Style of Key FOB Card with Reader] 
 

 
Note   
 
Key FOBs come in a variety of styles, so the Key FOB shown here may not exactly match the 
one you are using. 
 

Once you swipe the Key FOB, the user is automatically logged in. The user that is currently 
logged in will be displayed at the bottom left hand corner of the screen: 
 

 
 

 

Logging in Manually 
 

If you do not have a Key FOB, use these steps to manually log in a user. 

Begin by clicking the  button to make the User Tasks and User Collection panes 
visible. 
                  
 

The first way to manually log in a user: 
 

1.  Right-click the named user in the User Collection pane. 
 

2.  Select Log In from the context menu. 
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Notes 

    
    Items in the context menu that are in bold can be executed 

using a double-click or by pressing the Enter key on your 
keyboard. 
 
Double-click the user name or press Enter to log in. 
  

 

The second way to manually log in a user: 
 

1.  Select the named user in the User Collection pane. 
 

2.  Select Log this User In from the User Tasks pane. 
 

             
 

The name of the logged-in user is displayed in the bottom-left corner of the status bar. 

 

Logging Out A User 

 

The first way to log out a user: 
 

Click the  toolbar button. 
 

The second way to log out a user: 
 

Click the  button to make the User Tasks and User Collection panes visible. 
 

1.  Click the name of the user you wish to log out in the User Collection pane. 
 

2.  Select Log Out from the User Tasks pane. 
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The name of the user is now removed from the status bar 

 
All basic pertinent precautionary measures must always be taken into account when using a 
treadmill. Please therefore read this manual carefully and familiarize yourself with the 
operation of the unit and with all warning signs fitted to the machine. 
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PROGRAMS 

 

CREATING A NEW PROGRAM 

SAVING A PROGRAM 

REMOVING A PROGRAM 

LINKING A PROGRAM 

DELETING A PROGRAM 

EDITING A PROGRAM 

RUNNING A TIME PROGRAM 

RUNNING A DISTANCE PROGRAM 

RENAMING A PROGRAM 

2 
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Creating A New Program 

 
The program editor allows you to create a personalized workout program.  A program is 
composed of one or more stages.   
 

There are two ways to access the Program Editor: 
 

The first way to access the Program Editor: 
 

1.  Click the  toolbar button. 
                           
                                                                                                 

The second way to access the Program Editor: 
 

1.  Click the toolbar button. 
 

 

2.  Select Create New Program from the Program Tasks pane. 
 

 
 

 

For each stage of the workout, you can either base the length of the program on Time or 
Distance: 
 

Creating A Time Based Stage 
 

To create a Time Based Stage, make sure the Distance Based Program checkbox is NOT 
selected: 
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Then, enter numerical values in the Time, Speed and Elevation boxes. To add a new stage, 
click the New Stage button. The Distance will be automatically calculated based on the Time 
and Speed entries. 
 

 
 

 

Creating a Distance Based Stage 
 
To create a Time Based Stage, make sure the Distance Based Program checkbox is 
selected: 
 

 
 

Then enter numerical values in the Speed, Elevation and Distance boxes. To add a new 
stage, click the New Stage button. The Time will be automatically calculated based on the 
Speed and Distance entries. 
 
 

 
 

Saving the Program 
 
When you have entered all the stages for the program, select Save As from the Editor 
Control Pane. 
 

 
 

 
 
 
 
 
 
 



19 

 

The following dialogue box appears: 
 

 
 

1. Enter a name for the program in the Program Name field. This name will appear in the 
Programs Collection Pane.  
 

2. You man also enter a more detailed description of the program in the Description field. 
This description will appear in the Details Pane. 
 

3. Select Save. 
 

 

Notes 
 

¶ Type the first letter of your desired instruction while the Instruction drop-down list has 
focus to quickly change the instruction without having to use the mouse. 

 

¶ Select the check box so that pressing the tab key cycles through 
New Stage, Time, Speed, Load, and Instruction for faster data entry.    

 

¶ Click to insert a new blank stage at the end of your list of stages. 
 

¶ Click to insert a new blank stage at any position in your list of stages.  

 



20 

 

¶ You may also click-and-drag the stages in the Program Editor window to change the 
order in which the stages are displayed. 

 

¶ Click to copy a selected (highlighted) stage and place it on the clipboard. 
 

¶ Click to paste a copied or cut stage into the Program Editor window in the 
desired position. 

 

¶ Click to cut or remove a selected stage from the Program Editor window 
and place it on the clipboard. 

 

¶ Click to permanently delete a stage. 

 

¶ You may also press the Delete key on your keyboard to delete a selected stage: 
   

Right-click anywhere in the Program Editor window 
to open the context menu.  Pressing the shortcut 
keys located next to each editor task allows you to 
perform the respective action without having to use 
your mouse. 

 

 

 

The icon shown before the program indicates if it is a time based program or a distance 
based program: 
 

= Time Based Program 
 

= Distance Based Program 
 

Saving A Program 

 

When you're ready to save a new program, click Save 
As... in the Editor Control pane. Enter a program 
name and an optional description. 
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The program name and description are now visible in 
the Details pane. 
  

 

 

   

You can now access your program from the User 
Collection pane.  Expand the tree view by clicking the 

 to access your program. 

  

 

 

   

Changes to a program that already has been named 
can be saved by clicking Save in the Editor Control 
pane. 
  

 

 

Removing A Program 

 
Removing a program is different than deleting a program.  Removing a program causes the 
program to be removed from the User Collection pane but not from the Programs pane. You 
would choose this option in situations where you wish to remove a particular program from a 
user but retain it in the list of programs for future use.  
 

Click the  toolbar button. 
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Right-click the program in the User Collection pane 
and select Remove Program from the context 
menu. 

          Note 
      •      

            You may also select Remove this Program 
from the User Tasks pane. 

 

 

 

 

 

A message is displayed reminding you that the program will only be removed from the users 
contents but not from the Programs list.  
 

 
 

 

   

Note 
 

Å     The program is not removed from the list of programs 
in the Programs pane. 
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Linking A Program 

 

Linking a program allows you to associate any program with any user. A user can have more 
than one program and the same program can be linked to different users. 

Click the  toolbar button. 
 

Log in the user who will be the recipient of the linked program                             
 

Click the  toolbar button. 
 

Right-click the program you wish to link from 
the list in the Programs pane and select Link 
Program from the context menu.   
  

 Note 
 

      •     You may also select Link this 
Program to Logged In User from the 
Program Tasks pane.  
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From the following dialogue box, select the users you want to link to the program by checking 
their box  in the Include column: 
 
 

 
 

 

 

For this example, a program named Sample Program has been linked to a user named Jane 
Smith. 
 

 
  
 

Note  
 
The icon shown before the program indicates if it is a time based program or a distance 
based program: 
 

= Time Based Program 
 

= Distance Based Program 
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Deleting A Program 

 
When a program is deleted from the Programs pane, the program will be permanently 
deleted from the programs pane and also from all of the users within the user collection who 
are linked to the program.  The program along with all references to the program will be 
deleted from the database. 
 

Click the  toolbar button. 
 

 

Right-click the program you wish to delete 
from the Programs pane and select Delete 
Program from the context menu.  
 

  

      Note 
  

      •    You may also select Delete this 
Program from the Program Tasks 
pane. 

  

 

 
  

 

 

Note 
 

You may also delete the selected program by pressing the Delete key on your keyboard.  

 

 
 

  3.  Select Yes. 
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Editing A Program 

 

Any modifications to a program will be automatically applied to all programs of the same 
name that are linked to other users.  
 

 

The first way to edit a program: 
 

Click the  toolbar button 
 

Right-click the program you wish to edit from the 
Programs pane and select Edit Program from 
the context menu. 

      Note  
      •      
          You may also select Edit this 

Program from the Program Tasks 
pane. 
  

 

 
  

 

 

The second way to edit a program: 
 

Click the  toolbar button. 
 

Right-click the program you wish to edit from the 
User Collection pane and select Edit Program 
from the content menu. 

   Note 
  

      •     You may also select Edit this 
Program from the User Tasks pane. 
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Enter numerical values in the Time, Speed, Elevation and Distance boxes. To add a new 
stage, click the New Stage button. 
 

 

 
 

Editing a Time Based Stage 
 

To create a Time Based Stage, make sure the Distance Based Program checkbox is NOT 
selected: 
 

 
 

Then, edit the numerical values in the Time, Speed and Elevation boxes. To add a new 
stage, click the New Stage button. The Distance will be automatically calculated based on the 
Time and Speed entries. 
 

 
 

 

Editing a Distance Based Stage 
 
To create a Time Based Stage, make sure the Distance Based Program checkbox is 
selected: 
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Then edit the numerical values in the Speed, Elevation and Distance boxes. To add a new 
stage, click the New Stage button. The Time will be automatically calculated based on the 
Speed and Distance entries. 
 

 
 

 

 

Notes: 
 

¶ Type the first letter of your desired instruction while the Instruction drop-down list has 
focus to quickly change the instruction without having to use the mouse. 

 

¶ Select the check box so that pressing the tab key cycles through 
New Stage, Time, Speed, Load, and Instruction for faster data entry.    

 

¶ Click to insert a new blank stage at the end of your list of stages. 
 

¶ Click to insert a new blank stage at any position in your list of stages.  
 

¶ You may also click-and-drag the stages in the Program Editor window to change the 
order in which the stages are displayed. 

 

¶ Click to copy a selected (highlighted) stage and place it on the clipboard. 
 

¶ Click to paste a copied or cut stage into the Program Editor window in the 
desired position. 

 

¶ Click to cut or remove a selected stage from the Program Editor window 
and place it on the clipboard. 

 

¶ Click  to permanently delete a stage. 
 

¶ You may also press the Delete key on your keyboard to delete a selected stage. 
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Right-click anywhere in the Program Editor window 
to open the context menu.  Pressing the shortcut 
keys located next to each editor task allows you to 
perform the respective action without having to use 
your mouse 

 

 

The icon shown before the program indicates if it is a time based program or a distance 
based program: 
 

= Time Based Program 
 

 = Distance Based Program 
 

 

Running A Time Program 

 

Time Based programs measure each stage by how long you have exercised,  
 

When a time based program appears in the User Pane, it uses the following icon: 
 

 
 

The first way to run a Time Based program: 
 

Click the  toolbar button. 
 

 

Right-click the program you wish to run from the Programs Collection pane and select Run 
Program from the context menu. 
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Notes 
 

•    Items in the context menu that are in bold can be 
executed using a double-click or by pressing the 
Enter key on your keyboard. 
  
Double-click the program name or press Enter to 
open the Workout pane to run the program.       
   
  

 

 

You can also run a program by clicking Run this Program from the Program Tasks pane: 
 

 
 

 

The second way to run a program: 
 

Click the  toolbar button. 
 

 

 

Expand the tree in the User Collection pane by 
clicking the until you reach the program you 
wish to run, then right-click the program and 
select Run Program from the Context menu.  

            Note 
   

         • You may also run a program by 
clicking Run this Program from 
the User Tasks pane. 
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Notes 
 

• Items in the context menu that are in bold can be executed using a double-click or by 
pressing the Enter key on your keyboard. 
 

• Double-click the program name or press Enter to open the Workout pane to run the 
program.       

 

   

Press the Start button in the Workout Control 
pane to begin running the program. 
 

To pause the workout at any time, press the 
Pause button. To re-start the workout when it is 
paused, press the Pause button again. 
 

NOTE: The Group Mode checkbox only appears 
if it is selected on the Options Tab.  It is used to 
run the workout for more than one person. 

 

 

Stage View 
   

The Stage View window displays the details of each 
stage of your program as it runs. It displays the current 
stage number, the time the next stage will start and the 
stage time length of the current stage. As one stage 
ends and another begins, the details of the new stage 
replace the former. 
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The progress bar displays the current status of 
the program as it runs. 
  

 

 

When the program finishes, the window below will be displayed.  By default, the Result Name 
will consist of the date and time of the workout.  However, you can enter any name you wish 
in the Result Name text box.  You may also enter any additional information in the Notes text 
box. Check the Generate Graph Now check box and the Generate Report Now check box to 
generate a graph and a report immediately after the workout is saved. 

 

 
 

Running A Distance Program 

 

 Distance Based programs measure each stage by how far you have gone  
 

When a distance based program appears in the User Pane, it uses the following icon: 

 
 

The first way to run a Distance Based program: 
 

Click the toolbar button. 
 

Right-click the program you wish to run from the Programs Collection pane and select Run 
Program from the context menu. 
 

   



33 

 

 

Notes 
 

•   Items in the context menu that are in bold can be 
executed using a double-click or by pressing the 
Enter key in your keyboard. 
 
Double-click the program name or press Enter to 
open the Workout pane to run the program.       
   
  

 

 

You can also run a program by clicking Run this Program from the Program Tasks pane: 
 

 
 

 

The second way to run a program: 
 

Click the toolbar button. 
 

 

 

Expand the tree in the User Collection pane by 
clicking the until you reach the program you 
wish to run, then right-click the program and 
select Run Program from the context menu.  

            Note   
          
          You may also run a program by 

clicking Run this Program from 
the User Tasks pane. 
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Notes 
 

• Items in the context menu that are in bold can be executed using a double-click or by 
pressing the Enter key on your keyboard. 
 

• Double-click the program name or press enter to open the Workout pane to run the 
program.       
 

   

Press the Start button in the Workout Control pane to 
begin running the program. 
 

To pause the workout at any time, press the Pause 
button. To re-start the workout when it is paused, press 
the Pause button again. 
 

NOTE: The Group Mode checkbox only appears if it is 
selected on the Options Tab. It is used to run the 
workout for more than one person.  

 

 

   

The Stage View window displays the details of each 
stage of your program as it runs. It displays the current 
stage number, the distance the next stage will start 
and the stage distance length of the current stage. As 
one stage ends and another begins, the details of the 
new stage replace the former. 

 

 

 

   

The progress bar displays the current status of 
the program as it runs. 
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When the program finishes, the window below will be displayed.  By default, the Result Name 
will consist of the date and time of the workout.  However, you can enter any name you wish 
in the Result Name text box.  You may also enter any additional information in the Notes text 
box. Check the Generate Graph Now check box and the Generate Report Now check box to 
generate a graph and a report immediately after the workout is saved.      

 

 
 

 

Renaming A Program 

 

The first way to rename a program: 
 

 

Click the  toolbar button. 
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Right-click the program you wish to rename from 
the Programs pane. Click Rename from the 
context menu. Type the new name and press 
Enter.   
  

 

 

      

The second way to rename a program: 
 

 

Click the  toolbar button.  
 

 

   

Right-click the program you wish to rename from the 
User Collection pane.  Click Rename from the 
context menu.  Type the new name and press Enter.  
  

 

 

 

Notes 
 

• Another way to rename a program is to select it, then click it again.  Type the new name and 
press Enter. 
 

• Any changes to the program name will be automatically applied to all programs of the same 
name that are linked to other users. 
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RESULTS 

 

SAVING RESULTS 

DELETING RESULTS 

GENERATING A REPORT FROM RESULTS 

GENERATING A GRAPH FROM RESULTS 

RUNNING A PACE WORKOUT 

RENAMING A RESULT 

EXPORT TO CSV 

 
 
 
 
 

3 
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Saving Results 

 

When you save a workout program, the collected data is stored as a result.  You can save as 
many results as you wish.  Once you save a result you can run a pace workout, generate a 
report, or generate a graph from the collected data. 
     
 

Begin by running a program 
 

When the program finishes, the window below will be displayed.  By default, the Result Name 
will consist of the date and time of the workout.  However, you can enter any name you wish 
in the Result Name text box.  You may also enter any additional information in the Notes text 
box. Check the Generate Graph Now check box and the Generate Report Now check box to 
generate a graph and a report immediately after the workout is saved.         
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Expand the Results folder in the User Collection 
pane tree to access the saved result.  

 

   

Group Mode Results 
 

If you run a program in Group Mode, individual results are saved under each user's profile 
 
 

Deleting Results 

 

Locate the result you wish to delete by expanding the tree in the User Collection pane.  
 

Right-click the result and select Delete 
Result from the context menu. 
 

 

 

  Note 
 

  •    You may also delete the selected 
result by pressing the Delete key on 
your keyboard.  

 

 

Click the Yes button to confirm the deletion of the named result 
 

 Generating A Report From Results 

 

A report contains detailed data collected from your saved results 
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Expand the tree in the User Collection pane by clicking the  until you reach the desired 
result. 
 

 
 
 

Right-click the result and select Generate Report from the context menu. 
 

 
 

 

The report that is displayed in the Reports window contains all of the recorded data from the 
program you executed.  The data contained in the report includes the following: 
 

 

• The name of your result is displayed to the right of Performance Report. 
 

• The name of your user is displayed to the right of User Name.  
 

• The date and time you executed your workout program is displayed to the right of Time 
Executed.  
 

• The default Units Configuration under the Totals heading is Time (Seconds), Distance 
(Miles), Work (Joules). 
 

• The default Units Configuration under the Averages heading is Heart Rate (Beats/min), 
Speed (Miles/Hour), Elevation (%), Pace (Min/Hr), METs, and Work/Hr (Joules/Hr). 
 

• The default Units Configuration under the Peaks heading is Heart Rate (Seconds), Speed 
(Seconds), Elevation (Seconds), Pace (Seconds), METs (Seconds) and Work/Hr (Seconds). 
 

• Each element (Distance, Speed, Elevation, Heart Rate, Pace, METs and Work/Hr) are color 
coded and correspond to an individual line on the graph.  
 

• The Notes section displays information you optionally provided when you saved your 
workout.  
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Notes 
 

• The toolbar button refreshes the report, resetting its property to default.   
 

• The toolbar button prints the report 
 

• The toolbar button returns the report to Print Layout if the Zoom property was changed. 
 

• The toolbar button allows you to change the  Page Setup properties. 
 

• The toolbar button gives you the option to export your report as a Microsoft® Excel 
spreadsheet or an Acrobat® (PDF) file.  
 

• The drop-down list changes the site of the report as it's viewed in the Reports 
window.    
 

 

Generating A Graph From Results 

      

Expand the tree in the User Collection pane by clicking the  until you reach the desired 
result. 
 

Right-click the result and select Generate Graph from the context menu. 
 

                
 

Select the position where you want the graph to appear. Graph 1 is the top position and 
Graph 2 bottom.   
 

Notes  
 

• Each element (Distance, Speed, Elevation, Heart Rate, Pace, METs and Work/Hr) are color 
coded and correspond to an individual line on the graph.  
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• As you move the mouse over the graph, the values are dynamically updated to reflect the 
changes in the line position. 
 

• Click-and-drag with the left mouse button to create a box around a specific area of the 
graph, then release to zoom in.  
 

• The entire graph can be repositioned by clicking and holding the right mouse button and 
dragging the graph to the desired location.   
 

• Refresh the graphs to their original state at any time by click the button in the 
Graph Tasks pane.  
 

• Click the button in the Graph Tasks pane to print the graphs.  
 

Running A Pace Workout 

 
The pace workout compares distance at the same point in time as the result you ran the pace 
workout against. Pace distance is the distance from the previous runner that created the 
recorded result at the same point in time. Relative distance is the distance between the 
person currently running and the position of the previous runner that created the recorded 
result at the same point in time. A negative value indicates that the runner trails the previous 
runner that created the recorded result. A positive value indicates that the runner is leading 
the previous runner that created the recorded result.   
 

   

Pace Distance represents the distance from the previous 
runner that created the recorded result at the same point in 
time. 
 

If the Lag Alarm check box is checked, when the distance 
of the runner falls below that of the previous runner, the 
alarm will sound alerting the runner to speed up. Once the 
runner reaches or exceeds the distance of the previous 
runner, the alarm will shut off.  

 

 

   
   

Relative Distance, as labeled on the gauge, is the 
distance between the person currently running and 
position of the previous runner that created the 
recorded result at the same point in time. The odometer 
displays your current relative position. 
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Open the Results folder in the User Collection pane to 
access the result you wish to run a pace workout from.  
Right-click the result and select Run Pace Workout 
from the context menu. 
  

 Note 
 

     •      You may also select Run Pace 
Workout from the User Tasks 
pane. 

 

 

 

Notes 
 

¶ Items in the context menu that are in bold can be executed using a double click or by 
pressing the Enter key on your keyboard. 

 

¶ Double-click the result name or press Enter to run a pace workout. 
 

   

Press the Start button in the Workout Control pane 
to begin running the pace workout.  
   
To pause the workout at any time, press the Pause 
button. To re-start the workout when it is paused, 
press the Pause button again. 
 

Note:  
 
The Group Mode checkbox only appears if it is 
selected on the Options Tab  It is used to run the 
workout for more than one person  

 

 

   

The progress bar displays the current status of 
the result as it runs. 

 

 

When the result finishes, the window below will be displayed.  By default, the Result Name 
will consist of the date and time of the workout.  However, you can enter any name you wish 
in the Result Name text box.  You may also enter any additional information in the Notes text 
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box. Check the Generate Graph Now check box and the Generate Report Now check box to 
generate a graph and a report immediately after the workout is saved.           
 

                           
 

   

If you run a program using the default 
units configuration, save the workout, 
then modify the units configuration from 
the Options page and try to run a pace 
workout you will receive a warning 
message. Click the Yes button to change 
the units to the recorded unit values and 
continue.  
  

 

 
 

Renaming A Result 

 

Click the toolbar button to make the Users pane visible.  
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Expand the Results folder in the User Collection 
pane tree to access the saved result(s).  

 

 

 

Right-click the result you wish to rename. Click 
Rename from the context menu. Type the new 
name and press Enter.  

 

 

 

Note 
 

• Another way to rename a result is to select it, then click it again.  Type the new name and 
press Enter. 

Export to CSV 

 

Export to CSV allows you to export a Result record to a CSV (comma separated value) file. 
 

   

Right-click the result you wish to export.  Click 
Export to CSV from the context menu.  By 
default, the file will be given the same name as 
your result, unless it contains any of the 
Windows illegal file name characters (? [ ] / \ = + 

< > : ; " , * |).  You will have to rename default 
Performance Trainer Pro Results that are 
exported since they contain illegal file name 
characters. 
The default directory is: 
Document*\My Performance Pro Exports 
  

 

 

The CSV file can be opened in MS Excel. 
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Report Configuration 
 
This is where a user can pre-configure the header and footer images for all generated 
reports allowing users to create professional looking reports with their own company or 
association logos. 
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TASK PLANES 

 

USERS PANE 

PROGRAMS PANE 

WORKOUT PANE 

PROGRAM EDITOR PANE 

REPORT PANE 

GRAPHS PANE 
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Users Pane 

 

User Tasks Pane 
 

The User Tasks pane is interrelated with the User Collection pane and contains selections 
related to users, programs, and results.  The selections will change depending upon what is 
selected in the User Collection pane below it, with the exception of the first three choices.   
 
They are listed below.   

 

                                                                                         

• Click the button to create a new user 
                                                                   

• The button collapses the tree in the User Collection pane. 
 

• The button logs out the user currently logged in. 
 

 

When you select a named user from the User Collection pane: 
 

• Click the button to log in the selected user 
 

• Click the button to edit the selected user 
 

• Click the button to delete the selected user. 
 

 

When you select a named program from the Programs folder of the User Collection pane: 
 

• Click the butt*n to run the selected program 
 

• Click the button to edit the selected program.       
 

• Click the button to remove the selected program.       
 

When you select a named result from the Results folder of the User Collection pane:  
 

• Click the button to view a report containing the details of the result 
 

• Click the button to view the details of the result in the form if a graph 
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• Click the button to run a pace workout 

User Collection Pane 
 

The User Collection pane stores the collection of users and their related data.  
 

 

Click the toolbar button to access the User Collection pane.     
 

   

Users, programs, and results are stored in an 
expandable tree.  Click the  next to the 
respective item to expand that section of the 
tree.   
   

 

Programs can be either Time Based or Distance Based. 
 

When a time based program appears in the User Pane, it uses the following icon: 

 
 

When a distance based program appears in the User Pane, it uses the following icon: 

 
 

For example: 

 
 

If you run a group workout, each user's results are saved both separately under each user's 
profile and the complete results are saved under Group Results. 
 

 
 

 

Note: 
 
You can also search for users with the keyboard.  Click the Users toolbar button, then click 
anywhere in the User Collection pane to set the focus.  Begin by typing the last name of a 
particular user and the User Collection pane will resolve and match the user you are 
searching for with each key stroke in succession.  This is also functional for Programs and 
Results, but the search only responds to what is visible.  Items collapsed in the tree are not 
included in the search.   
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Details Pane (Users) 
 

The Details pane is interrelated with the User Collection pane and displays details relating to 
users, programs, and results.  The selections will change depending upon what is selected in 
the User Collection pane. 
 

 

   

Select a user from the User Collection pane to 
display details associated with that particular user.  

 

 

   

Select a program name from the User 
Collection pane to view its details 
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Select a result from the User Collection pane to view 
its details. 

 

 

 

Programs Pane 

Program Tasks Pane 
 

• Click the  button to create a new program 
 

• Click the button to run the selected program 
 

• Click the button to edit the selected program 
 

• Click the  button to link the selected program to one or more users 
 

• Click the  button to delete the selected program 
 

Programs Pane 
 
When a program is deleted from the Programs pane, the program will be permanently 
deleted from the programs pane and also from all of the users within the user collection who 
are linked to the program.  The program along with all references to the program will be 
deleted from the database. 
 

The Programs pane is a master list where programs are stored.  Select a program from the 
list and choose an option from the Program Tasks pane. 
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You may also right-click a program from the list 
and choose an option from the context menu. 
  

 

 

Note 
 

You can also search for programs with the keyboard.  Click the Programs toolbar button, then 
click anywhere in the Programs pane to set the focus.  Begin by typing the name of a 
particular program and the Programs pane will resolve and match the program you are 
searching for with each key stroke in succession.  This is also functional for Users and 
Results, but the search only responds to what is visible.  Items collapsed in the tree are not 
included in the search.   

Details Pane (Programs) 
Select a program from the Programs pane to view its details.  The date and time you last 
modified or made any changes to the program can be viewed below the Date Modified 
heading. 

 

 
 

 

 



53 

 

 

 

Workout Pane 

 

Workout Tasks Pane 
 
• Click the button to log out the currently logged in user 
 

• Click the button to begin running the opened program.   
 

• Click the button to stop the currently running program. 
 

• Click the button to open the Users pane. 
 

• Click the button to open the Programs pane. 
 

• Click the button to reset the values on all of the gauges to zero. 
 

Workout Control Pane 
 
Click the Start button in the Workout Control 
pane to begin running a program or a pace 
workout. 
 

To pause the workout at any time, press the 
Pause button. To re-start the workout when it is 
paused, press the Pause button again. 
 

Note  
 
The Group Mode checkbox only appears if it is 
selected on the Options Tab.  It is used to run the 
workout for more than one person.  

  

 

 

Note 
  •    You may also click the Start 

Workout button from the 
Workout Tasks pane. 
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Running Group Mode 
 

Whenever you run a workout, you have the option of running it in Group Mode. To do this, 

check the Group Mode selection on the Workout Control Pane. 
 

 
 

Note 
 
If the Group Mode checkbox does not appear on the Workout Control Pane, go to the Options Tab (See 5.5) and 
check the 
 

  box. 
 

Group Mode means that multiple users can switch off during the workout. Think of it like a relay race. One user 
starts, and at any time in the workout another user can take the place of the current user. The handoff is done 
through the use of a Key FOB, a cord or other device that contains a unique number for each user.  
 

 
One Style of Key FOB Card with Reader 
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Note   
 
Key FOBs come in a variety of styles so the Key FOB shown here may not exactly match the one you are using. 
 

Once the new user swipes the Key FOB over the reader, the current user is logged off and the new user is 
automatically logged in. The user that is currently logged in will be displayed at the bottom left hand corner of 
the screen: 
 

 
 

After the workout, each user's results are saved separately under each user's profile. The complete results are 
saved under Group Results. 
 

 
 

 

Command State Pane 
 

The Command State pane displays an image of a runner. The runner becomes animated when you begin 
running a program, pace workout, or manual workout, but remains stationary otherwise. 
 

 
 

Progam Editor Pane 

Editor Tasks Pane 
 

• Click to insert a new blank stage at the end of your list of stages. 
 

• Click to insert a new blank stage at any position in your list of stages.  
 



56 

 

• You may also click and drag the stages in the Program Editor window to change the order in which the stages are 
displayed. 

 

• Click to copy a selected (highlighted) stage and place it on the clipboard. 
 

• Click to paste a copied or cut stage into the Program Editor window in the desired position. 
 

• Click to cut or remove a selected stage from the Program Editor window and place it on the 
clipboard. 

 

• Click to permanently delete a stage. 
 

• You may also press the Delete key on your keyboard to delete a selected stage. 
 

Editor Control Pane 
 

When you're ready to save a new program, click Save 
As... in the Editor Control pane. Enter a program name 
and an optional description. 
  

 

 

   

Changes to a program that already has been named can 
be saved by clicking Save in the Editor Control pane. 
  

 

 

 

Details Pane (Program Editor) 
 

The Details pane displays the name and the description you optionally assigned to the opened program. 
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Reports Pane 

 

Report Tasks Pane 
 

To access the Report Tasks pane, select a result and click the button from the User Tasks 
pane.  You may also right-click a result from the User Collection pane and select Generate Report from the 
context menu.  
 

 

• Click the button to create a new user. 

(see Creating a New User(See 1.1)) 

 

• Click the button to logout the currently logged in user. 

(see Logging Out a **er(See 1.5)) 

 

• Click the button to create a new program. 

(see Creating a New Program(See 2.1)) 

 

• If you make changes to any of the items in the Reports pane, you need to click the link to 
make the changes appear in the report. 

 

Graph Control Pane 
 
Each element (Distance, Speed, Elevation, Heart Rate, Pace, METs and Work/Hr) are color coded and 
correspond to an individual line on the graph. At any time, you may change which elements appear in the graph 
by selecting any number of check boxes. 
 
If you make changes to any of the items in the Graph Control pane, you need to click the 

link to make the changes appear in the report 
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Distance Splits 
 
The distance splits will show up to 10 incremental 
distance points of time.  If you entered 10 for 
example, and your distance units were yards, you 
would get 10 data points consisting of the time at 
every ten yards. 
  

 

 

Click the button to make the Distance Splits table visible in the report. 
 

If you make changes to any of the items in the Distance Splits pane, you need to click the 

link to make the changes appear in the report.  

 
 

Graphs Pane 

 

Graph Tasks Pane 
 

To access the Graph Tasks pane, select a result and click the button from the User Tasks 
pane.  You may also right-click a result from the User Collection pane and select Generate Graph from the 
context menu. 
 

 

• Click the button to create a new user. 

(see Creating A New User(See 1.1)) 

 

• The button logs out the user currently logged in. 

(see Logging Out a User(See 1.5)) 

 

• Click the button to create a new program. 

(see Creating a New Program(See 2.1)) 

 

• Refresh the graphs to their original state at any time by click the button. 
 

• Click the button to print the graphs. 
 

Graph Control Pane 
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When you generate a graph, select the position you want the graph to appear in. Graph 1 is the top position and 
Graph 2 bottom.  
 

• Check which graph, Graph 1 or Graph 2, you want to appear in the window. If you check them both, Graph 1 is 
displayed on top and Graph 2 is displayed on the bottom. 
 

           
 

• Each element (Distance, Speed, Elevation, Heart Rate, Pace, METs and Work/Hr) is color coded and 
corresponds to an individual line on the graph. 
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TABBED WINDOWS 

 

WORKOUT TAB 

PROGRAM EDITOR TAB 

GRAPHS TAB 

REPORTS TAB 

OPTIONS TAB 
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Workout Tab 

 

Manual Mode 
 

Click the toolbar button to run a manual workout. Its details are displayed in the Workout tab. 
The manual workout is a way to create a baseline for a runner for a designated period of time. It requires no 
setup other than logging in a user in order to begin collecting the results. If you do not want to save the results of 
the session, you can run the manual workout without logging a user in. However, a dialog box will appear before 
the workout, informing the user that the data results will not be collected.  When prompted with this dialog, if the 
user clicks the Yes button, the manual workout will begin.  If the user clicks the No button, the workout will not 
start and the user will automatically be taken to the User Collection pane to log in a user.  If a user is logged in 
when the Start button is clicked in the Workout Control pane, the manual workout will run indefinitely until the 
user clicks the Stop button. 
   

Adjust the Speed 
 

Before starting the workout, adjust the Speed to where you 
want to start the workout: 
 

the plus sign raises the speed 
 

the minus sign lowers *he speed 
 

You can also adjust the speed at anytime during the workout. 

 

 

 

   

Adjust the Elevation 
 

Before starting the workout, set the Elevation to where 
you want the workout to start. 
 

the plus sign raises the elevation 
 

the minus sign lowers the elevation 
 

You can also manually adjust the elevation at anytime 
during the workout. 
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Set The Stop Workout Markers 
 

Use the Stop Workout Markers window to enter specific values for Time, Distance, Work or Heart Rate. When 
checked, the stop markers will automatically stop the running workout at the entered value for the selected stop 
markers.  You can have multiple stop markers active at one time.  When multiple stop markers are active, the 
first value that matches the running workout will stop the running workout. 
 

 
 

 

OPTIONAL: Select an Optional Operation Mode 
 

These options will ONLY appear if you selected them on the Options Tab(See 5.5).  
   

If both options appear, you can only 
select one at a time. 
 

 

 
Checking the Reverse option allows you to run the 

treadmill motor in reverse. The speed dial will 
show a negative speed  

 

 
Checking the Dynamic option turns the motor of 

the treadmill off. The speed of the treadmill is then 
completely determined by the speed of the runner. 

 

Start the Workout 
      

Press the Start button in the Workout Control pane. 
 

To pause the workout at any time, press the Pause 
button. To re-start the workout when it is paused, press 
the Pause button again. 
 

NOTE: The Group Mode checkbox only appears if it is 
selected on the Options Tab(See 5.5).  It is used to run 
the workout for more than one person. See Running 
Group Mode(See 4.3.3) for details.  

 

 

To manually stop the running workout, click the Stop button. The window below will be displayed. By default, the 
Result Name will consist of the data and time of the workout.  However, you can enter any name you wish in the 
Result Name text box.  You may also enter any additional information in the Notes text box.  Check the 
Generate Graph Now check box and the Generate Report Now check box to generate a graph and a report 
immediately after the workout is saved. The results from a manual workout are stored in the results folder of the 
logged in user, in the User Collection pane. 
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Heart Rate Mode 
 

Click the toolbar button to run a heart rate based workout. Its details are displayed in the Workout 
tab. The heart rate workout is a way to achieve and maintain a particular heart rate for a runner for designated 
period of time. It requires no setup other than logging in a user in order to begin collecting the results. If you do 
not want to save the results of the section, you can run the manual workout without logging a user in.  
However, a dialog box will appear before the workout, informing the user that the data results will not be 
collected.  When prompted with this dialog, if the user clicks the Yes button, the manual workout will begin. If the 
user clicks the No button, the workout will not start and the user will automatically be taken to the User 
Collection pane to log in a user.  If a user is logged in when the Start button is clicked in the Workout Control 
pane, the heart rate workout will run indefinitely until the user clicks the Stop button. 
   

Adjust the Speed 
 

Before starting the workout, adjust the Speed Dial to the 
speed at which you want to start the workout: 
 

the plus sign raises the speed 
 

the minus sign lowers th* speed 
 

You can also adjust the speed at anytime during the workout. 
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Adjust the Elevation 
 

Before starting the workout, set the elevation Dial to 
where you want the workout to start. 
 

the plus sign raises the elevation 
 

the minus sign lowers the elevation 
 

You can also manually adjust the elevation at anytime 
during the workout. 

 

 

Set Maximum Levels 
 

 

 

 

When you start a Heart Rate workout, the software 
will adjust the speed and/or elevation to help you 
achieve your target heart rate. You can use these 
fields to limit the maximum levels to which these 
values will be adjusted. You can continue to make 
adjustments during the workout. 

 

   

Set Target Heart 
Rate 
 

 

 

 

Set this field to set the target heart rate before the 
workout. You can also adjust this field during the workout. 
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Set Control Mode 
 

 

 

When you start a Heart Rate workout, the 
software will adjust the speed and/or elevation 

to help you achieve your target heart rate. 
 

Select Speed and Elevation to use both. 
 

Select Speed to adjust only the speed. The 
elevation will remain constant. 

 

Select Elevation to adjust only the elevation. 
The speed will remain constant.  

   

Set Weight 
 

 

 

 

 

The weight is taken from your user profile. If you want, you can adjust the 
weight before the workout starts.  

 

Start the Workout 
           
Press the Start button in the Workout Control pane. 
 

To pause the workout at any time, press the Pause 
button. To re-start the workout when it is paused, press 
the Pause button again. 
 

NOTE: The Group Mode checkbox only appears if it is 
selected on the Options Tab(See 5.5). It is used to run the 
workout for more than one person. See Running Group 
Mode(See 4.3.3) for details.  

 

 

To manually stop the running workout, click the Stop button. The window below will be displayed. By default, the 
Result Name will consist of the date and time of the workout.  However, you can enter any name you wish in the 
Result Name text box.  You may also enter any additional information in the Notes text box.  Check the 
Generate Graph Now check box and the Generate Report Now check box to generate a graph and a report 
immediately after the workout is saved. The results from a manual workout are stored in the Results folder of the 
logged in user, in the User Collection pane. 
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Programmed Mode 
 

A programmed workout or program is created in the Program Editor 

(see Creating a New Program(See 2.1)) 

 

When you run a program, its details are displayed in the Workout tab 

(see Running a Program(See 2.8)) 

  
 

Pace Mode 
 

When you run a pace workout, its details are displayed in the Workout tab 

(see Running a Pace Workout(See 3.5)) 

 

Interval Mode 
 

Click the toolbar button to run an interval workout. Its details are displayed in the Workout 
tab. The interval workout allows you to go back and forth between two speed/elevation settings. It requires no 
setup other than logging in a user in order to begin collecting the results.  
 

If you do not want to save the results of the session, you can run the manual workout without logging a user in. 
However, a dialog box will appear before the workout, informing the user that the data results will not be 
collected.  When prompted with this dialog, if the user clicks the Yes button, the manual workout will begin.  If 
the user clicks the No button, the workout will not start and the user will automatically be taken to the User 
Collection pane to log in a user.  If a user is logged in when the Start button is clicked in the Workout Control 
pane, the interval workout will run indefinitely until the user clicks the Stop button. 
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Set Values for Each 
Interval 
 

 

 

There are two Speed/Elevation adjustment fields, one 
for the first interval and another for the second. Set 

these before starting the workout. You can also adjust 
these values during the workout. 

 

   

Toggle Interval 
 

 

 

 

Use this button to switch between intervals. The currently 
selected interval is indicated by the green Active light: 

 

 
  

 

   

Set Weight 
 

 

 

 

 

The weight is taken from your user profile. If you want, you can adjust the 
weight before the workout starts.  

 

Start the Workout 
           
Press the Start button in the Workout Control pane. 
 

To pause the workout at any time, press the pause 
button. To re-start the workout when it is paused, press 
the Pause button again. 
 

NOTE: The Group Mode checkbox only appears if it is 
selected of the Options Tab(See 5.5). It is used to run the 
workout for more than one person. See Running Group 
Mode(See 4.3.3) for details.  

 

 

To manually stop the running workout, click the Stop button. The window below will be displayed. By default, the 
Result Name will consist of the date and time of the workout.  However, you can enter any name you wish in the 
Result Name text box.  You may also enter any additional information in the Notes text box.  Check the 
Generate Graph Now check box and the Generate Report Now check box to generate a graph and a report 
immediately after the workout is saved. The results from a manual workout are stored in the Results folder of the 
logged in user, in the User Collection pane. 
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Program Editor Tab 

 

The Program Editor tab is displayed when you create a new program or edit an existing program 

(see Creating a New Program(See 2.1), Editing a Program(See 

2.6))                                                                                                                                                                           

Graphs Tab 

 

The Graphs tab is displayed when you generate a graph from a result 

(see Generating a Graph from a Result(See 3.4)) 

 

Reports Tab 

 

The Reports tab is displayed when you generate a report from a result. 

(see Generating a Report from a Result (See 3.3)) 

 

Options Tab 

 

Click the button on the toolbar to open the Options tab. 
 



69 

 

 

Communications Configuration: 
   

These controls are used to set the particular computer port (such 
as a USB port) that the treadmill and heart rate devices are 
attached to.  
 

Usually, you can use the Auto Config button to automatically find 
the device. If this doesn't work, check the connection and try 
again. If the connections are secure but the Auto Config still 
does not work, you may have to manually select the appropriate 
port. 

 

 

Belt Creep Adjustment: 
   

"Belt Creep" occurs when the treadmill is improperly 
calibrated. This can result in the actual speed not 
matching desired speed shown on the Workout Tab. If 
the belt moves on its own while you are not running a 
workout, use these controls to adjust the belt creep until 
the belt is completely stationary. 

 

 

 

Units Configuration: 
   

This is where the user can set the desired units they 
prefer to work with.  The Units Configuration can be 
modified at any time, but pace workouts can only run 
in the same units they were recorded in. 
 

 

  If you run a program using the default units configuration, save 
the workout, then modify the units configuration from the Options 
page and try to run a pace workout, you will receive the following 
warning message. Click the Yes button to change the units to the 
recorded units values and continue.  
 

 

 

 

Range Configuration: 
 

This is where the user can set the upper speed limit and elevation range that will appear during workouts. 
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Feature Options: 
   

 
 

Check the Enable Reverse Mode box 

to enable the Reverse Mode Option. This option 
allows the treadmill to run in reverse, (speed will 

show as negative). Checking it here only makes it 
available on the Workout tab. 

To activate this mode, it must also be selected 

on the Workout tab. 

 
 

Check the Enable Dynamic Mode box 

to enable the Dynamic Mode Option. This option 
allows you to turn off the treadmill motor and the 
speed will be determined by the user. Checking it 
here only makes it available on the Workout Tab. 

To activate this mode it must also be selected 

on the Workout tab. 
 

 
 

Check the Enable Group Mode box to enable the Group Mode option.  This option then appears on the Workout 
Control pane(See 4.3.2) For more information on group mode,see Running Group Mode(See 4.3.3). 

 

 

 
 
 
Database Configuration: 
 

This field tells the program where to find the Performance Pro database. Usually, the default value works best if 
you are using a single treadmill. If you want to change the location (for example, if you want multiple treadmills 

to have access to a common database located on a server), click on the folder icon and select the new 
database location.  
 

 
 

The database file is named 

PerformanceTrainerPro.mdb 
 

If you install the program into a directory on a network drive, move the database file to the same directory before 
selecting it from the Database Configuration field. 
 

 

Report Configuration: 
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This is where a user can pre-configure the header and footer images for all generated reports allowing users to 
create professional looking reports with their own company or association logos. 
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TOOLBAR BUTTONS 

 

USERS TOOLBAR BUTTON 

PROGRAMS TOOLBAR BUTTON 

MANUAL MODE TOOLBAR BUTTON 

HR MODE TOOLBAR BUTTON 

INTERVAL MODE TOOLBAR BUTTON 

LOGOUT TOOLBAR BUTTON 

NEW USER TOOLBAR BUTTON 

NEW PROGRAM TOOLBAR BUTTON 

OPTIONS TOOLBAR BUTTON

6 
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Users Toolbar Button 

 

Click the toolbar button to access user-related data.  The User Tasks pane contains selections 
related to users, programs, and results.  The User Collection pane stores the collection of users and their 
related data.  The Details pane is interrelated with the User Collection pane and displays details relating to 
users, programs, and results.  The selections will change depending upon what is selected in the User 
Collection pane. 
 

Programs Toolbar Button 

 

Click the toolbar button to access program-related data.  The Program Tasks pane contains 
selections related to programs.  The Programs pane stores the programs you created. The Details pane 
contains the name, description, and the date and time you last modified or made any changes to the selected 
program. 
 

Manual Mode Toolbar Button 

 

Click the toolbar button to open the Workout tab for a manual workout 

(see Manual Mode(See 5.1.1))   

 

HR Mode Toolbar Button 

 

Click the toolbar button to open the workout tab for a Heart Rate workout 

(see Heart Rate Mode(See 5.1.2)) 

 

Interval Mode Toolbar Button 

 

Click the toolbar button to open the Workout tab for an interval workout. 

(see Interval Mode(See 5.1.5)) 

 

Logout Toolbar Button 
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Click the toolbar button to log out the currently logged in user 

(see Logging Out a User(See 1.5)) 

 

New User Toolbar Button 

 

Click the toolbar button to create a new user 

(see Creating a New User(See 1.1)) 

 

New Program Toolbar Button 

 

Click the toolbar button to open the Program Editor tab, allowing you to create a new 
program.  The Editor Tasks pane contains selections related to program editing.  The Editor Control pane is 
used to save a new or existing program. The Details pane displays the name and the description you optionally 
assigned to the opened program 

(see Creating a New Program(See 2.1)) 

 

Options Toolbar Button 

 

Click the toolbar button to open the Options tab 

(see Options Tab(See 5.5)) 
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MENU BAR 

 

ACTIONS 

VIEW 

EDITOR 

HELP 
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Actions 

 

New User Menu Item 
 
Click the Actions menu bar item.  Select New User from the sub menu 

(see Creating a New User(See 1.1), New User Toolbar Button(See 6.7)) 

 

New Program Menu Item 
 
Click the Actions menu bar item.  Select New Program from the sub menu 

(see  Creating a New Program(See 2.1), New Program Toolbar Button(See 6.8)) 

 

Workout Menu Item 
 
Click the Actions menu bar item.  Select Workout from the sub menu 

(see Manual(See 5.1.1), Workout Toolbar Button(See 6.3)) 

 

Logout Menu Item 
 
Click the Actions menu bar item.  Select Log Out from the sub menu. 

(see Logging Out a User(See 1.5), Log Out Toolbar Button(See 6.6)) 

 

Clean Programs Collection Menu Item 
 
Click the Actions menu bar item.  Select Clean Programs Collection from the sub menu.  Choose this option to 
delete all programs that are not linked to or associated with any users.  All programs that are assigned to users 
will be retained in the list and will not be deleted.  
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View 

 

Users Menu Item 
 
Click the View menu bar item.  Select Users from the sub menu 

(see Users Toolbar Button(See 6.1)) 

 

Programs Menu Item 
 
Click the View menu bar item.  Select Programs from the sub menu 

(see Programs Toolbar Button(See 6.2)) 

 

Options Menu Item 
 
Click the View menu bar item.  Select Options from the sub menu 

(see Options Tab(See 5.5)) 

 

Editor 

 

Insert Stage Menu Item 
 
Click the Editor menu bar item.  Select Insert Stage from the sub menu to insert a new blank stage at any 
position in your list of stages. 
 

Note   
 
You must have the Program Editor tab opened to insert a stage 

(see Creating a New Program(See 2.1), Editing a Program(See 2.6)) 

 

Copy Stage Menu Item 
 
Click the Editor menu bar item.  Select Copy Stage from the sub menu to copy a selected (highlighted) stage 
and place it on the clipboard. 
 

Note 
 
You must have the Program Editor tab opened to copy a stage 

(see Creating a New Program(See 2.1), Editing a Program(See 2.6)) 
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Paste Stage Menu Item 
 
Click the Editor menu bar item.  Select Paste Stage from the sub menu to paste a copied or cut stage into the 
Program Editor window in the desired position. 
 

 

Note   
 
You must have the Program Editor tab opened to paste a stage 

(see Creating a New Program(See 2.1), Editing a Program(See 2.6)) 

 

 

Cut Stage Menu Item 
 
Click the Editor menu bar item.  Select Cut Stage from the sub menu to cut or remove a selected stage from the 
Program Editor window and place it on the clipboard. 
 

Note   
 
You must have the Program Editor tab opened to cut a stage. 

(see Creating a New Program(See 2.1), Editing a Program(See 2.6)) 

 

Delete Stage Menu Item 
 
You must have the Program Editor tab opened to delete a stage 

(see Creating a New Program(See 2.1), Editing a Program(See 2.6)) 

 

Help 

 

Search Menu Item 
 
Click the Help menu bar item.  Select Search from the sub menu to open the search tab in the help window.  To 

search for topics, enter words or phrases in the text box and click the  button.  Matching topics are 

then displayed.  Select a topic from the list and click the  button to view the help topic. 
 

• Click the  button to string words together using the joins AND, OR, NEAR, NOT. 
 

• Check the check box to search for words from the previous result. 
 

• Check the check box to display topics that include part of the word you're searching for.  
For example, if you're searching for the word "Programs", and you check the Match similar words check box, the 
result will also include topics that contain the word "Program".  
 

• Check the check box to search for words that are only contained in a title. 
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Contents Menu Item 
 
Click the Help menu bar item.  Select Contents from the sub menu to open the contents tab in the help window.  
Expand the tree by clicking the until you reach the desired topic.  Click the topic to display its contents.   

 

Index Menu Item 
 
Click the Help menu bar item.  Select Index from the sub menu to open the index tab in the help window.  Enter 

the title of a known topic and click the button to view the topic. 
 

Note 
 
Only those topics that begin with the entered keywords will be displayed. 

 

Support Menu Item 
 
Contact Info: 
   

SALES DEPT. 
 

Woodway 

 

W229 N591 Foster Ct. 
Waukesha, WI 53186 
 

Phone: 262-548-6235 

Toll Free: 1-800-Woodway 
 

Fax: 262-522-6235 

 

Email: info@woodway.com  

Website: www.woodway.com 

  

SERVICE DEPT. 
 

Woodway 

 

W229 N591 Foster Ct. 
Waukesha, WI 53186 
 

Phone: 262-548-6235 ext 150 

Toll Free: 1-800-Woodway ext 150 
 

Fax: 262-522-6235 

 

About Menu Item 
 
Click the Help menu bar item.  Select About from the sub menu to view Woodway Performance Trainer Pro 
details 
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